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Mixcraft™ Overview 
Mixcraft™ is a multitrack audio mixer with effects, featuring Reverb, Delay/Echo, EQ, Compression, 
Flanger and Chorus, as well as resonant filters and a powerful loop editor.  The high performance 32 bit 
sound engine supports broadcast quality WAV files and will even import compressed MP3s & WMA files.  
Use it to record your own music, your band or even a remix for a dance recital.  The amazing fact about 
home recording today is that you really only need a computer and a good multitrack recording program 
such as Mixcraft to create amazing sound!  When you’ve finished your mix, publish it to the Internet as an 
MP3, WMA or RealAudio file, or render it to a WAV and burn it to a CD. 

 

Unleash your creative side! 
Using your computer's microphone or an external hardware mixer, you can record your own voice, guitars, 
drums or your kid*. (*Assumes you have a kid.  Doesn’t everyone? ;-))  

 

Who can use it ? 
DJs, pro and amateur musicians, bands, practicing singers, radio people, webmasters, 
professors, teachers, students, employees, dance studios, gym & spinning instructors, game 
designers, movie makers, sound designers and the list goes on! 

 

What can you use it for? 
Recording music, recording a DJ dance mix, creating a mix for a dance recital, creating a 
presentation for your company, creating a work out mix, recording your own audio book, creating 
a funny off the wall answering machine message, creating audio homework, splitting up big 
contiguous songs into multiple songs, trimming songs, cutting out audio mistakes, and most 
importantly FUN! 

 

MIXCRAFT™ FEATURES 

� Easy to use multitrack audio mixing! 

� Unlimited tracks depending on your computer’s processing power! 

� Pan, volume, solo and mute on each track. 

� Cutting edge 32 bit sound engine for maximum sonic quality! 

� Read and write high quality audio, including broadcast quality 24 & 32 bit WAV files up to 192 
kHz. 

� Import compressed MP3, WMA and WAV files! 

� 6 Powerful Effects including 

o Reverb – Simulate environments  

o Delay – Create multiple echo effects  
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o EQ – Boost bass, treble, mid-range, 10 band EQ  

o Compression – Boost dynamics to sound louder  

o Flanger – Create a whooshing effect  

o Chorus – Double up your vocals 

� Shape your sounds with resonant filter automation.  Great for DJs! 

� Easy looping tools – Create loops out of sections of other sounds or songs. 

� Render to Realaudio, MP3, WMA and WAV, including broadcast WAV files at high sample rates 
and bit depths.  (Includes 24 and 32 bit sounds and sample rates up to 192kHz) 

� Create mix CDs. 

 

 

Quick Start 
So you’re in a hurry, eh?  Let’s follow our favorite musician "Sound Warrior" (SW) through 
the paces of using Mixcraft ™.    

 

Load in sounds 

SW starts Mixcraft and clicks "Add Sound" from the "Mix" menu.  He finds a groovy beat 
called ‘funky-groove-120-bpm.wav’ and clicks "OK".  

 

Position sounds 

SW clicks on the new sound and moves it to track 1 so that it starts at the beginning of the track. 

 

Create loop 
To add looping, SW moves his mouse to the right side of the sound until the cursor looks like a 
<-> .  SW clicks and drags right to loop the sound.  Each loop is represented by a tick so that he 
can visibly measure out 10 loops. 

 

Change filter over time 
SW wants the loop to grow in intensity over time and instead of just changing the volume over 
time, he decides he wants to change the frequency over time!  SW clicks on the "Show Env" 
control on the toolbar and switches it to "Low Pass Cutoff"  He moves the mouse to the first 
envelope point and drags it down to the bottom of the sound.  Then he switches the "Show Env" 
control to "Low Pass Resonance" and adjusts the first envelope point to the top.  He proudly 
listens to the piece of art by clicking the Play button on the toolbar.  "Not bad!" he thinks. 
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Add more sounds 
He adds a bass part and a synth pad on tracks 2 & 3.  He then records some vocals on track 4 that 
go like this "yo baby, you know I luv ya…" you get the idea. ;-)  Something is missing though…  

 

Add Effects 

He decides to add some echo or delay to his vocals so that "yo baby" sounds more like "yo yo baby baby".  
He clicks on the "FX" button on track 4 and selects "Delay" from the list.  In a sudden inspiration, he 
decides that the whole thing needs reverb and clicks "Main FX" on the master control panel to add global 
reverb.  Now it sounds just right! 

 

Mix it down to MP3 

For the final step, he needs to mix it down to a single sound.  He chooses "Mix Down To" followed by 
clicking "MP3".  He selects a filename and clicks save.  Without hesitating he launches his email browser 
and starts composing a new message to his current #1 fan.  "Dear Mom, you’ve gotta check out this new 
piece I made!!!" 

 

 

Registration / Purchasing Options 
Mixcraft has a trial period of 7 days without any restrictions!  After that, you will need to purchase a 
registration code to continue using the software. 

 

We have put many hours into this software and we hope that you decide to purchase the software! 

 

Benefits of Registration 

o Unlimited and unrestricted usage: mix to your heart’s content!  

o Support Acoustica and future products of the same caliber. 
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You can purchase a registration code right now and automatically receive a registration code in your 
email within minutes.   

 

BUY NOW!  

To purchase a registration code, click the "Buy Now On-line" item from the "Help" menu or the "BUY" 
button on the toolbar. 

 

If you don’t have the software up now, visit the website to purchase a code.  Go to 
www.acoustica.com/buy.htm  

 

Purchase methods 

o Credit card  

o Pay Pal – pay via the popular service Pay Pal 

o Snail mail or postal mail – send in a mail with a money order or check.  

o Phone Order - Make a call to send payment. 

 

The price of registration is not much more than the cost of a large pizza!  The price may actually vary 
which is why it isn’t listed here.  (More instructions are on the website.) 

 

Once you purchase the software, you should receive instructions on completing the registration and 
entering in your serial code.  However, if you do not hear back within 1 day, please visit the following 
support site.  Lost Codes Department  

 

 

Main Window 
 

Tracks 

Tracks are what hold the sounds.  Each track can have its own Effects, volume and pan adjustments.  These 
settings only affect the sounds on the track.  More on Tracks 
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The above image shows the track header, the track and a sound on the track. 

 

Master Control 

This is the global or master panel, which effects the entire mix.  After all the tracks have been 
processed, the sound signal is sent through the Master Control where volume and master 
effects are applied.  For example, it will give you much better performance to use an overall 
reverb on the Master Control versus applying the same reverb on every track.  

 

 

The Caret 

The caret represents the location where new sounds will be placed.  It is also where new 
recordings will be placed.  Before recording or adding sounds, make sure to move your caret 
to the desired location.  Zooming in and out uses the caret as the zoom point. Position the 
caret before zooming in or out.  (A nice trick when zooming in and out is to spin the middle 
mouse wheel.) 

 

 

Timeline 

The timeline is above the track area and helps you to line up sounds at specific times.  You 
can also add markers to the timeline, which can help with lining up  More on the timeline.  

 

Menus & Toolbar 

The toolbar contains many of the common functions, including zooming and envelope 
selection.  Explore the menus for new features.  Menus - Toolbar  

 

Status Bar 

This displays information about the selected sound(s) or the mix, depending on what is active. 
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Sound Basics 
Each sound or clip can be edited in a variety of ways.   

 

(Here is what a sound clip looks like in Mixcraft.) 

 

This sound is called "Drum Loop".  You can play it individually by clicking the play arrow.  
The sound clip has a title bar, wave form, envelope, and a selection area on the bottom.  Each 
sound can be cropped, faded, edited in a few simple clicks and drags.  Cut, copy and paste is 
also extremely easy. 

 

Adding Sounds 

To add a sound, position the caret and click the "Add Sound" button on the toolbar.  
Alternatively, double clicking on an empty area on the track will allow you to choose a sound.  
Locate the sound and click "Open".  Alternatively, you can drag in multiple sounds directly 
from a Window’s folder.  Mixcraft currently supports WAV, MP3 and WMA files. 

 

Selecting Sounds 

To select a sound, click its title bar.  Alternatively, you can select a portion of the sound by 
clicking on the bottom selection part of the sound and dragging left or right.  To select 
multiple sounds, click down in the window and drag over the sounds or portions of sounds 
you’d like to select. 

 

Moving Sounds 

Simply click on the title bar of the sound clip and drag it to a new location.  You may also use 
the keyboard to move the sound.  Note that sounds can overlap and coexist at the same 
location if desired. 

 

Deleting Sounds 

Simply select the sound or sounds and click "Cut" from the "Edit" menu or press the "Delete" 
key on the keyboard. 

 

Cropping Sounds  

Copy & Paste  
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Crossfading Sounds  

Editing sounds with a 3rd party sound editor  

Playback Rate  

Envelopes  

Looping  

Recording  

 

Cropping Sounds 
By clicking on the right or left hand side of a sound and dragging left or right you can crop 
the sound.  You would do this to get rid of extra silence or other unwanted audio.  

 

(The figure below shows a sound being cropped on the left hand side.) 

 

 

You can crop from the left or right side.  Note that all envelope points will also be cropped. 

 

 

Clipboard: Copy, Cut, & Paste 
Select a sound or group of sounds and cut or copy.  Cut will delete the selection and store the 
cut in the clipboard.  Choose paste to paste the selection you just cut.  Copy copies the current 
selection to the clipboard (without deleting the selection).  You can select portions of sounds, 
as well by clicking on the bottom selection area of the sound and dragging left or right.  Cut, 
copy and paste menu items are located on the "Edit" menu or by right clicking on a selection.  

 

 

(The image above shows a selection of a part of a sound.) 
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To select a part of a sound, simply click on the bottom ‘selection’ area and drag the mouse left 
or right. 

 

 

Cross Fading Sounds 
Drag a sound onto another sound so that they overlap.  A cross section area will be drawn on 
the overlapped area, which represents the auto cross fade.  Sound will fade from one clip to 
the next clip.  This is a very powerful feature!   

 

 

(The white diagonal lines represent the fade out of the first sound and the fade in of the 
second sound!) 

 

Note that if a sound is entirely within another sound, it will not auto cross fade and will 
simply mix. 

 

 

Editing Sounds with a 3rd Party Sound Editor 
If you want to apply effects or editing not possible in Mixcraft, you can work with an external 
sound editor.  Make sure that you have already setup an external sound editor in the 
Preference dialog.   

Right click on the sound you want to edit and select "Edit in External Editor".  This brings up 
a dialog with two main choices. 

o Edit a copy of the sound. 
This option is the preferred method of editing a sound because if you later decide you don’t like it, 
you will be able to undo the edit.  In addition, you can have Mixcraft automatically pick a name 
for the new sound, thereby saving you the trouble.  This will happen if the "Automatically choose 
a new name for the sound" checkbox is checked.  You can also simply type in a new filename or 
browse to find one. 

o Edit the original sound.   
This makes permanent non-undoable changes.  You might choose this if the sound is extremely 
large and you can’t afford the disk space to make a copy.  The con to this option is that it is not 
reversible! 

Once you have picked an edit option, click the Edit button and it will launch the external 
editor with the sound.  Another dialog box appears which waits for you to finish your editing.  
Make all the changes you want in the external editor, and save the file (in the external editor).  
Go back to Mixcraft and hit either Done or Cancel, depending on how the edit went.  In the 
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case of editing the original sound, it won’t make a difference.  However, if you edited a copy 
of the sound, Cancel will delete the copy from your hard drive. 

 

 

Sound Clip Envelope Basics 
Each sound clip allows you to shape 6 parameters over time, so that you can, for example, 
fade audio in, and out, cut the volume in certain locations, pan from left to right speaker over 
time and more.  Each sound starts out with 2 envelope points at the start and end of the sound. 
You can click on an envelope point and move it around to the desired location.   

 

(The above image shows how to move an individual point.) 

 

 

To add a point, move the mouse until it becomes a pencil tool, then left click and a new 
envelope point will be added. 

 

 

You can move an "envelope line" by clicking on a horizontal line and dragging it up or down. 

 

To switch the type of envelope, click the "Show Env" drop down on the toolbar. 

 

Each sound has volume, pan, Low Pass Cutoff, Low Pass Resonance, High Pass Cutoff & 
High Pass Resonance envelopes. 
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Volume 

Add envelope points for fades, cuts, or boosts, raising or lowering the sound’s volume.  The 
range is 0% to 200%. 

 

Pan 

Add envelope points to pan the sound from left to right speaker.  The range is 100% left 
speaker to 100% right speaker. 

 

 

Low Pass Cutoff & Low Pass Resonance 
The Low Pass Cutoff limits the high frequencies that are played.  It lets the low frequencies 
‘pass’ or ‘get through.’  This is similar to turning down the treble knob on a stereo.  

 

Low Pass Cutoff: The cutoff represents a frequency value is between 0% and 100%.  The default is 100% 
and means you hear all frequencies in the sound.  0% equates to a very low cut off frequency and you 
would not hear any sound.  

 

Low Pass Resonance:  As this value increase, the overtones near the cutoff frequency are boosted. The 
result is that the cutoff frequency is much louder than the rest of the audio being filtered.   

 

IMPORTANT: The Low Pass Cutoff works hand in hand with the Low Pass Resonance.  The Low Pass 
Resonance setting will not be audible if you haven’t adjusted the Low Pass Cutoff!  

 

Tips: 

� To use the resonant filter creatively, try a resonant filter sweep.  To do this, set the Resonance 
envelope at 200 and create a Cutoff envelope that rises and falls slowly.  Since the resonant value 
is relatively high (200), as the cutoff goes up and down you should distinctly hear the "resonant 
peak" follow the cutoff, with its characteristic sound.  For example, the famous wah-wah pedals 
used by guitarists, makes use of resonant filter sweeps back-n-forth, with the cutoff controlled by 
the foot pedal. 

� If the resonant setting is cranked all the way up to 256, the filter goes into a state called "self-
oscillation" and produces a ringing-whistling tone. ATTENTION: this can be very loud and 
overwhelming, so please watch your audio levels as it can be dangerous for your ears and your 
speakers!! 

� Using resonant filter sweeps on synthesizer melody lines can make some very musically 
compelling timbre and tone changes, to signal a transition, a buildup or a bridge. 
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* The cutoff % is a mapped logarithmically from 200 Hz to ½ sample rate. 

 

 

High Pass Cutoff & High Pass Resonance 
The High Pass Cutoff limits the low frequencies that are played.  It lets the high frequencies 
‘pass’ or ‘get through.’  This is similar to turning down the bass knob on a stereo.  

 

High Pass Cutoff:  The high pass cutoff value represents a frequency between 0% and 100%.  The default 
is 0%, which allows all frequencies to pass. 100% is essentially silent and does not let any high frequencies 
be heard. 

 

High Pass Resonance:  As this value increase, the overtones near the cutoff are boosted. The result is that 
the cutoff frequency is much louder than the rest of the audio being filtered.   

 

IMPORTANT: The High Pass Cutoff works hand in hand with the High Pass Resonance.  
The HIgh Pass Resonance level will not be audible if you haven’t adjusted the High Pass 
Cutoff!  

 

Tips: 

� To use the resonant filter creatively, try a resonant filter sweep.  To do this, set the Resonance 
envelope at 200 and create a Cutoff envelope that rises and falls slowly.  Since the resonant value 
is relatively high (200), as the cutoff goes up and down you should distinctly hear the "resonant 
peak" follow the cutoff, with its characteristic sound.  For example, the famous wah-wah pedals 
used by guitarists, makes use of resonant filter sweeps back-n-forth, with the cutoff controlled by 
the foot pedal. 

� If the resonant setting is cranked all the way up to 256, the filter goes into a state called "self-
oscillation" and produces a ringing-whistling tone. ATTENTION: this can be very loud and 
overwhelming, so please watch your audio levels as it can be dangerous for your ears and your 
speakers!! 

� Using resonant filter sweeps on synthesizer melody lines can make some very musically 
compelling timbre and tone changes, to signal a transition, a buildup or a bridge. 

 

* The cutoff % is a mapped logarithmically from 200 Hz to ½ sample rate. 

 

 

Looping Sounds 
Working with loops in Mixcraft is easy.   
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Creating a looped sound 

Select a sound and move your mouse to the right edge.  The mouse should turn into a <-> 
cursor.  Click and drag to the right.  As you drag the mouse to the right, it creates loops.  Each 
loop is represented with a ‘v’ mark. 

 

(The image above shows a sound looped 3 times.) 

 

Perfecting a loop 

You may have a sound that doesn’t loop well.  For example, many MP3s have extra silence 
and will not loop properly, so it is necessary to trim out the silence before looping.  Imagine 
we have a sound with 1 second of silence before the loop.  Right click on a sound and click 
"Edit Loop".    The Edit Loop window pops up and allows you to fine tune the loop. The 
green flag and line represents the loop start and the red flag represents the loop end.  Click the 
play icon to play the loop.  Adjust the start and end of the loop during playback.  Click the + 
to zoom in and the – to zoom out.  Once you are happy with the new loop, click "OK". 

 

Tips 

� Use this to remove silence from the beginning of MP3 file loops 

� Grab a chorus section or loop from a popular song and create a remix. 

� Create short loops to create interesting sound effects.  The minimum loop length is 100 
milliseconds or 1/10th of a second. 

 

 

Sound Playback Rate 
Change the playback rate of a sound by selecting "Adjust Clip Playback Rate" from the 
"Sound" menu.   

 

Slow it down to 25% or speed it up to 4 times the normal speed.   

 

This is similar to playing a record at the wrong RPM and will have a ‘chipmunk’ sound.  
Minor adjustments in rate will sound fine and is useful for matching up beats. 

 



 13 

Tracks 
Tracks are audio channels that have their own volume, pan and effects. 

 

 

Track Name 

Give your track a name, feed it some track food and love it dearly.  (What else could I write 
here? �)  

 

Volume & Pan  

After all sounds on the track have been mixed, each track has its own volume and pan 
adjustment.  You can either use the slider or type in a value via an edit box. 

 

Track Effects (FX) 

Each track has its own effects that are added after all sounds have been mixed together.  In addition, the 
effects are added after the track volume and pan have been applied.  To add or view effects, click the "FX" 
button on each track.  More on Effects … 

 

Mute 

Mutes or silences all sounds on a track.  Note: All muted tracks will stay muted during a mix 
down.  

 

Solo 

Solos this track so that it is the only track you hear.  This is convenient way to listen to a specific track 
without hearing the others.  Note that it is possible to solo more than one track, and, thus, you will hear all 
soloed tracks. 

 

Add a New Track 
To add a new track, click "Add Track" on the "Mix" menu or click the "Add Track" button below the 
lowest track header.  The other way to add a track is to simply drag or move a sound down. 
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Master Control 

 

 

Peak & Clip Meter 

The peak meter is a graphic way of showing how loud the mix is.  The red clipping meters will light up and 
stay lit for 5 seconds if the volume is too loud.  Generally, you should avoid clipping and it is 
recommended to lower either the master volume or another volume.  The above image shows clipping in 
both the left and right channel.  Tip:  Solo a track to see if it is clipping. 

 

Master Volume 

This is the master volume for the entire mix.  If your mix is too loud, lower the master volume to avoid 
clipping.  You can use the slider or type in a new value.  The range is 0% to 200%. 

 

Main FX 

The main effects are applied to the entire mix after all tracks have been mixed.  Usually, one 
might use a global reverb or possibly a compressor.  To edit the effects, click the " Main FX" 
button. 

 

 

Timeline 
The timeline helps you position your sounds.  Depending on your zoom level, you will see time in 
minutes:seconds or minutes:seconds:milliseconds.  If your mix is longer than an hour, you will see 
hours:minutes, etc. 

 

Playback control 
Click on the timeline during playback to start playing from the new location. 

 

Track Markers 
Track markers can be used to line up sounds and loops or note important events.  Each tracker marker can 
have a name.  Track markers can optionally represent a "CD Track Marker" which will cause Mixcraft to 
render out a new track when doing a multi-file mix down.  Use track markers to: 

� Create an audio soundtrack for a video, by adding a track marker for each important video event. 

� Sync up loops and sounds.  Zoom in and line up each sound to an exact millisecond. 

� Create a mix CD from exported WAV files so that each track marker represents a new track. 
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Add Track Marker 
To add a track marker, either double click on the timeline or right click and select "Add Marker".  Give 
you marker a name and optionally uncheck the "CD Track Marker" if you don’t want this marker to start 
a new track for a multi-file mix down. 

 

Play From Marker 
If you right click on a marker, you can start playback from the marker. 

 

Play From Previous Marker 
If you right click on the timeline, select this to start playback from the previous marker. 

 

Delete Marker 
Right click on the timeline and select "Delete Marker" to remove the marker. 

 

Delete All Markers… 
Right click on the timeline and select "Delete All Markers…" to remove all markers.  (Note that the first 
marker will never be removed.) 

 

See more on mixing down to multiple WAV files.  

 

More on the CD Track Marker?  

 

 

Effects Dialog 
Mixcraft™ comes with 6 default effects, which are used for the Main FX and track FX.  Click a track’s FX 
button or the "Main FX" button to bring up the Effects dialog.  Note that you can use all features of 
Mixcraft while the effects dialog is up, which includes playback controls! 

 

Adding an effect 

Choose an effect from the drop down list on the left side.  This will add an instance of the effect to the 
"Effects Chain List."  Note that you can add more than one instance of any effect.  For example, you could 
have 2 delays and 2 choruses.  Also, keep in mind that adding effects should be done cautiously as it tasks 
the capabilities of your computer’s processing power. 

 

Previewing Effects 
To hear an effect, simply select Play from the Mix menu or the toolbar.  Adjust the effects in real time as 
the sounds play.  (You do not need to close the effect dialog while it is playing!) 
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Effects Chain List 

Each effect dialog has a list of effects, also called the "Effects Chain List".  The effect chain allows you to 
‘chain’ or connect multiple instances of delay, reverb and others to the same track or to the Main FX.   The 
top of the list is the first effect.  

 

Disabling & Muting Effects 

Each effect on the Effects Chain List has a check box, which allows you to mute, and un-mute 
effects.  This is a convenient way to determine the difference the particular effect makes. 

 

Reordering Effects 

Each effect on the Effects Chain List is processed from top to bottom.  You can reorder the 
list by clicking on an effect and dragging it, or by selecting the effect and clicking "Up" or 
"Down". 

 

Deleting Effects 

Select an effect and click "Delete" and it will be removed from the Effects Chain List. 

 

Delay  

Reverb  

Chorus  

EQ  

Flanger  

Compressor  

  

 

 
Delay is used to create an echo effect.  It is a delayed copy or copies of the sound, usually at a 
reduced volume. 

 

Delay 

This parameter specifies how long to delay a copy of the sound.  You can choose from 1 
millisecond to 2000 milliseconds (2 seconds.)   (There are 1000 milliseconds in a second.) 
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Feedback 

This parameter specifies how much of the delayed signal gets delayed again.  This will create 
the illusion of multiple echoes.  You can choose from 0% to 95%.  0% would be result in 1 
echo, whereas a setting of 95% would result in a very 

 

Pan 

This parameter specifies where the delayed sound will be in terms of the stereo field.  Choose 
from the left speaker, center or the right speaker. 

 

Wet Mix 

The wet mix is the new sound created by this effect.  This specifies how much of the delay 
that you hear. You can choose from 0% to 100%.  0% is the same as muting the effect and 
100% would result in a maximum delay. 

 

Dry Mix 

The dry mix is the original sound.  This specifies how much of the original sound that you 
hear.  You can choose from 0% to 100%.  0% would result in no original sound and 100% 
would result in a 100% of the original sound. 

 

Tips 

� Use for special psychedelic effects. Turn up the feedback. 

� Use at a short offset for a drum loop that is in time with the loop. 

� Accentuate vocals or guitars with a short echo.  This can be especially useful on electric lead 
‘guitaring’ such as used on some Pink Floyd songs. 

 

 

 
Reverb is used to give your sound a natural feel.  Reverb is a simulation of the natural reflections that 
sound makes in a particular room or environment.   Reverb effects are used to simulate a sound in a place 
where it most likely was not recorded.  For example, using the "Canyon" preset on a drum loop will make it 
sound like it was recorded in a highly reverberant space such as a canyon or tunnel.  Modest amounts of 
reverb are generally regarded as pleasing and is almost universally applied to modern studio recordings to 
create a better feeling of space. 

 

Reverberation 
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This parameter controls the % of reflectivity that you hear.  A low reverberation setting is subtle and a high 
reverberation setting sounds like you’re in a cathedral.  The valid settings are from 0% to 100%. 

 

High Freq. Damping 

This parameter controls the reflectivity of higher frequencies.  A value of 0% allows all 
frequencies to reverberate.  Natural reverberation, around 50%, does not include higher 
frequencies.   The valid settings are from 0% to 100% 

 

Stereo Width 

This parameter controls the width of the reverb stereo field. The valid settings are from 0% to 
100%.  Setting it to 100% has more ‘presence’ and setting it to 0% has a ‘flatter’ feel. 

 

Wet Mix 

The wet mix is the new sound created by this effect.  This specifies how much of the reverb 
that you hear. You can choose from 0% to 100%.  0% is the same as muting the effect and 
100% would result in a maximum reverb.  

 

Dry Mix 

The dry mix is the original sound.  This specifies how much of the original sound that you 
hear.  You can choose from 0% to 100%.  0% would result in no original sound and 100% 
would result in a 100% of the original sound. 

 

Tips 

� Use for special effects such as "Foggy" or "Dripping Wet FX". 

� Add a light reverb such as "Room Medium" to give it a natural feel.  Be careful of ‘over-
reverberating’!  If you can hear the reverb, turn it down. 

� Usually, you’ll want to create reverb on the Master effects chain and not on a per track basis.  
Creating the same reverb on each track would be a waste of CPU processing power. 

 

 

 

 

 
EQ or equalization allows you to lower or raise the volume of specific frequency ranges.  This effect is 
comparable to the graphic equalizer control commonly found on stereo amplifiers.  The Acoustica EQ 
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effect can subtly color the sound or give you a dramatic change, from a low-fidelity sound of AM Radio to 
subtle mid-range boosts on a vocal recording.  

 

EQ bands 

You can change the amplification for 10 frequency bands by 18 dB.  The bands represent 32 Hz, 63 Hz, 
125 Hz, 250 Hz, 500 Hz, 1 kHz, 2 kHz, 4 kHz, 8 kHz & 16 kHz. 

 

Output Gain 

This allows you to raise or lower the equalized sound.  In some cases, a particular equalization might cause 
distortion and, thereby, you’d want to reduce the output gain. 

 

Reset 

This resets all frequency bands to their center position and the output gain to 0.  This is the default position 
and is the same as muting or disabling the EQ. 

 

Tips 

� Choose the "Telephonic" preset to make your mix sound like its going through a telephone. 

� Choose the "Lo-Fi" or "1960s" preset to make your mix sound like its on a cheap TV. 

� Try to avoid over equalizing.  Not all speakers are created equal.  For example, if you boost the 
bass real high, many systems may be able to play it properly.  Aim for the common denominator 
speakers.  Of course, if you are making a mix for a dance club, give it some more bass and then 
give it some more. � 

 

* EQ note:  If you are playing back sounds with lower sample rates such as 22,050 Hz or 
11,025 Hz, some of the higher bands will not have any audible effect as it is impossible to 
contain frequencies above ½ the sampling rate.  (An 11,025 Hz sound cannot contain 
frequencies above  5,012 Hz (Nyquist’s theorem) ) 

 

 

 
The compressor is one of the least glamorous effects and one of the least understood.  However, it can be 
very POWERFUL when used properly.  The compressor makes the dynamics more even.  The low volume 
sounds become louder and the high volume sounds become lower.  Compressors are used extensively in 
studio recordings, radio production and for live performances. 
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Compressors work by using an audio level sensing function to keep track of the sound level.  When the 
sound level gets too high for the right amount of time, it is reduced.  Once it is reduced, the entire signal 
can be amplified, allowing you to hear the low volumes better. 

 

The image above shows an original sound.  Notice the big difference between the peaks and valleys of the 
sound. 

 

 

The image above shows the sound with the Compressor effect on.  Notice that it is a stronger &  ‘fatter’ 
sound and the peaks and valleys are closer together. 

 

Threshold 

The audio  level where sound is compressed.  This effect is in dB .  The range is from 0 dB to 
–30 dB.  –30 dB represents the strongest threshold with the most amount of compression.  

 

Attack time 

This sound level needs to be above the threshold level for this amount of time in order to be 
compressed.  The valid settings are from 0.01 milliseconds (ms) to 150 milliseconds. 

 

Release time 

The release time is the length in time to restore the audio signal from being compressed back 
into its normal state.  The valid settings for the release time are from 10 milliseconds to 500 
milliseconds. 

 

Ratio 

This parameter indicates how much to compress once it is passed the threshold.  The valid 
range is from 1 to 35.  A value of 1 is no compression and 35 is the maximum amount of 
signal compression. 

 

Output Gain 
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This parameter adjusts the output gain of the compressor.  Note that this amplification will be 
in addition to automatic volume adjustments via the "Auto Gain Compensator". 

 

Auto Gain Compensation 

This will automatically adjust the gain on the compressed sound in addition to the "Output 
Gain" setting above.  Auto Gain Compensation boosts the audio signal to full strength.  
(Depending on the audio, you may need to additionally raise or lower the output gain.) 

 

Tips 

� Vocalists/Singers: Apply compression to even out the volume changes if the singer is moving to 
and from the microphone. 

� Presence booster:  Instead of applying EQ, you might try adding a compressor to vary tone quality 
of a recorded instrument. 

� Guitar / plucked sustain increase:  Normally, after a guitar string is plucked, the sound dies away.  
Light compression with a long release will increase the sustain. 

 

 

 

 

 
Chorus is an effect usually used to create a ‘fuller’ sound by doubling and modulating the sound.  It 
thickens the sound by doubling it and slowly varying the time offset of the copy. 

 

Delay 

This parameter specifies how long to delay the copy of the sound.  The range is from 10 milliseconds to 50 
milliseconds. 

 

Rate 

This parameter controls how fast the doubled sound  goes in and out of tune.  The range is from 0.1 Hz to 
2.0 Hz.   

 

Intensity 

This parameter controls how much the doubled sound is out of tune.  The range is from 0.01 ms to 10 ms. 
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Wet Mix 

The wet mix is the new sound created by this effect.  This specifies how much of the chorus 
that you hear. You can choose from 0% to 100%.  0% is the same as muting the effect and 
100% would result in a maximum chorus.  

 

Dry Mix 

The dry mix is the original sound.  This specifies how much of the original sound that you 
hear.  You can choose from 0% to 100%.  0% would result in no original sound and 100% 
would result in a 100% of the original sound. 

 

Tips 

� Use for vocals to give the illusion of multiple singers. 

� Use strong chorus intensity for a strange warbly effect. 

� Use on instruments such as keyboard or organ for a more full sound. 

� Use multiple instances of chorus at slightly different settings for more than one doubled voice. 

 

 

 
The Flanger is similar to Chorus, except that it has a feedback setting.  According to legend, the flanger 
was born when the Beatles were in the studio producing an album.  A tape machine was being used for an 
echo effect, when someone touched the rim of the reel, changing the pitch.  After a bit of fiddling and 
mixing of signals, that characteristic flanging sound was born.  The rim of the reel is also known as the 
"flange", hence the name. � 

 

Delay 

This parameter specifies how long to delay the copy of the sound.  The acceptable range is from 0.1 
milliseconds to 20 milliseconds.  This controls the intensity of the effect. 

 

Feedback 

This parameter specifies how much of the flanger sound is ‘re-flanged’ and sent back into the Flanger 
effect.  The acceptable range is from 0% to 95%. 

 

Rate 

This parameter specifies how fast the flanger ‘whooshes’ up and down. 
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Wet Mix 

The wet mix is the new sound created by this effect.  This specifies how much of the Flanger 
that you hear. You can choose from 0% to 100%.  0% is the same as muting the effect and 
100% would result in a maximum Flanger.  

 

Dry Mix 

The dry mix is the original sound.  This specifies how much of the original sound that you 
hear.  You can choose from 0% to 100%.  0% would result in no original sound and 100% 
would result in a 100% of the original sound. 

 

Tips 

� Use the "Classic" preset it to create a whooshing effect on sustaining sounds, such as vocals, 
pads. 

� Increase the feedback and rate to create a weird warpy sound effect.  "Insane Membrane" is a 
good warpy preset. 

 

Recording 
Mixcraft™ allows you to record audio through your soundcard.  To bring up the recording window, click 
the record button on the toolbar, or select "Record" from the "Mix" menu. 

 

Preparation 

One of the biggest problems is to make sure you are actually recording from the right input.  
If you look at the back of your computer, you’ll see the soundcard. If it’s dark back there, get 
a flashlight. �  You’ll want to make sure that you have either a microphone plugged into the 
microphone jack, or some other device such as a hardware mixer, record player, etc. plugged 
into the stereo input jack.  

� Microphone input : Make sure that it is a 1/8" mini. 

� Line-In input: Make sure that you connect a 1/8" stereo mini.  If you are recording from a 
record player, for example, you should get an RCA to 1/8" stereo cable.  The line input 
requires an amplified signal and you need to get a hardware mixer. 

 

Make sure you’ve selected the right source in the software!  Once you’ve plugged in your 
microphone or external source, you’ll want to make sure that you are set to record it in the 
software, as well.  In Mixcraft, click the "Record" button, followed by clicking the "Speaker 
icon" 
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.  This brings up the Window’s "Record Control".  This contains a variety of inputs to 
choose from.  The list will vary depending on your soundcard.  However, the input options 
might include MIDI, CD, Line-In, Microphone, Auxilary, Wave/DirectSound, WhatUHear, 
etc.  Click the "Select" checkbox on the one you’d like to record.  

� Choose Line-In to record from the Line-In 

� Choose Microphone if you have a microphone connected to the microphone jack on your 
soundcard. 

� If in doubt, choose "WhatUHear".  Note that this option may not be available on your soundcard. 

 

Recording options 

 Click this icon to bring up the recording preferences.  On the recording preferences you’ll have the 
options to change the recording sampling rate, bit depth and more.  See the Recording Preferences for 
additional information. 

 

 

Start Recording 

Before you record a sound, click the mouse on the position you’d like the new sound to start.  
If you are overdubbing, this will determine where playback starts, as well. 

 

The above picture shows the ‘caret’, which will also be the position where the newly recorded 
sound will start. 

 

The recording source should be the soundcard you’d like to record from.  If you’re lucky 
enough to have a soundcard with multiple inputs, choose the correct input.  

 

Click the   record button to start recording.  The peak meters will help you monitor your 
recording so that it doesn’t distort.  Try to stay in the ‘yellow’, which represents a strong 
signal.  If the clip meters turn red, they will stay red for 5 seconds. 
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When you are done recording, click the  stop recording button.  You will now be able to 
preview your recording.  If you messed up, click "Cancel" and try again. 

 

Otherwise, click either "Save" or "Save As…"  Note that the "Save" option provides a default name and 
saves you time if you don’t care what its called.  If the name and director are important, choose "Save As" 
and you’ll be able to choose a directory and name for the new sound. 

 

 

Recording tips 
These tips should help to get better sounding recordings! 

 

Line input vs microphone input 

On the soundcard, you’ll usually find 2 important input jacks: Line-In and Microphone.  Line-In is a stereo 
input, which means it expects a left and right channel.  The microphone input is a mono input and is not 
compatible with stereo input.   

 

According to many experts, line in is the only jack you should record from, which means that it is 
recommended to attach a hardware mixer.  You can purchase a good hardware mixer for under $100 via 
some online sites.  I’ve seen them for $40.  This will make a world of a difference.  Once you get a 
hardware mixer, you’ll need to plug it into your soundcard’s Line-In jack.  Check out 
http://www.zzounds.com/ or http://www.musiciansfriend.com/  Of course, make sure it has the right jacks 
such as an XLR microphone input. 

 

Get A Strong Recording 

If you have to crank up the volume to hear the recording or if you have tons of distortion, you’ll need to 
adjust your various volumes in order to get a better recording.  This would include adjusting volumes on 
external mixers, external audio devices, record players and the Windows sound mixer.  Set all your volume 
inputs to the midway point.  Start with the first device and raise the volume until it distorts, then lower it.  
Go to the next device in the chain and do the same.  Repeat this process to get the best signal.    

 

The Right ‘Mike’ microphone 

Generally, the microphone that comes with your computer is not going to get a good recording.  Even the 
cheap $20 microphones that they sell at computer stores are probably not going to cut it.  For some 
purposes, you can get okay recordings with the soundcard’s Mic input.  However, it is recommended that 
you get a condenser or dynamic microphone to plug into a hardware mixer.  There are some good dynamic 
microphones for $20 on the Internet.  You may need to get an ‘impedance matching transformer’ if your 
hardware mixer does not have XLR input.  For more information about microphones and other recording 
tips, we highly recommend home-recording.com.  Check out http://www.zzounds.com/  or 
http://www.musiciansfriend.com/  
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A Do It Yourself Pop Shield For Vocals 

Recording vocals can be a pain, especially if you don’t have a pop shield.  A pop shield is used to reduce 
the ‘popping’ sounds that come from consonants like P & B.  This type of pop sounds like wind blowing on 
a microphone and its very unprofessional.  You can either go buy a pop shield or you can simply make one!  
Just get a pair of nylon tights/panty hose and a wire coat hanger.  Bend the coat hanger into a circle of 
around 20 cm or 8 inches in diameter.  Stretch the nylon tights around the hole.  Secure the other end of the 
wire on the microphone or to another surface so that it is in front of the microphone.   Happy non-plosive 
recording! � 

 

Mix Down / Mastering 
You’re done and ready to mix it down to a single file or multiple files!  Congratulations!  
Mixcraft currently supports mixing down to WAV, MP3, WMA and Realaudio.  Choose "Mix 
Down To" from the "File" menu and then choose the format you are interested in. 

 

WAV  

WAV files are the most widely supported file types.  Unfortunately, these are also the largest 
file type.  This would be the best option if you are burning audio CDs.  More on exporting to 
WAV  

 

MP3  

MP3 files are the most popular way of encoding sound at this time.  This would be the best 
option if you are sending your MP3 files to the Internet, are creating an MP3 data cd, or are 
sending them to a portable MP3 device.  More on exporting to MP3  

 

Realaudio™  

Realaudio files were the first highly compressed file format to hit the Internet.  Choose this 
option if you wish to create a realaudio file for streaming over the Internet.  More on 
exporting to Realaudio.  

 

WMA  

WMA files are Windows Media Audio files.  This is a smaller and compact alternative to 
MP3 files.  It is not as widely supported as MP3 files are but, since this is the Microsoft 
format, it has a funny way of becoming more popular every day. �  More on exporting to 
WMA  
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Mix Down to a WAV file 
WAV files are the most widely supported file types.  Unfortunately, these are also the largest 
file type.  This would be the best option if you are burning audio CDs. 

 

� Destination File Size - This is a helpful indicator that estimates how big the destination file size is 
going to be.   

� Render All/Selection - The default is to render the entire session.  However, you can also render 
the current selection.  You might choose to render the selection if you want to hear how it sounds 
under a certain sample rate, bits and stereo combination.  (You wouldn’t have to render the entire 
session which could take a while depending on the length of the session.) 

� Sample rate – enter or select a sample rate.  CD quality is 44,100 Hz.  If, in doubt, choose 44,100 
Hz.  Selections include 8 kHz to 192 kHz, but you may type in any sample rate. 

� Bit depth – choose from 8, 16, 24, 32 or 32 bit float.  CD quality is 16 bits.  If, in doubt, choose 16 
bits. 

� Channels – choose from Mono or Stereo.  CD quality is stereo. 

� User Information – Enter in the title, author and copyright if desired. 

� Create a separate WAV for each track marker – This option will be enabled if you have more than 
one CD Track Marker.  If you select this option, Mixcraft will create a WAV file for each section 
of audio.  More on track markers  

 

 

Mix Down to a MP3 file 
MP3 files are the most popular way of encoding sound at this time.  This would be the best option if you 
are sending your MP3 files to the Internet, are creating an MP3 data CD, or are sending them to a portable 
MP3 device. 

 

� Destination File Size - This is a helpful indicator that estimates how big the destination file size is 
going to be.  It is an approximation, though, especially when rendering to variable bit rate MP3 
files which depend on the actual audio content. 

� Preset Quality - Adjust the slider and choose one of the presets to set the desired MP3 quality.  
More info on presets … 

� Specify Exact Settings - You can also set the exact format to encode to.  For example, if you want 
to create a variable bit rate MP3, you’ll need to use this option.  More on setting the specific 
encoding settings  

� File Information – Mixcraft adds authoring information to the MP3 file.  It creates an ID3V1 and 
ID3V2 tag by default.  You can fill in the Title, Author, Copyright, Genre, Year and Comment. 

� Create Separate MP3 File For Each CD Marker? This option will be enabled if you have more 
than one CD Track Marker.  If you select this option, Mixcraft will create an MP3 file for each 
section of audio.  More on track markers 
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Specify MP3 Settings 
This dialog lets you fine tune the exact format, bit rate and tag information for your freshly converted MP3 
files.   

 

� MPEG Version - MPEG stands for "Moving Pictures Experts Group" and is based on a perceptual 
coding scheme.  There are several versions of the MPEG standard.  (MPEG defines the syntax of low 
bit-rate video and audio bit streams, and the operation of conformant decoders. MP3 is actually an 
abbreviation for MPEG 1 Layer 3.) 

 

MPEG Version  L.A.M.E.   

===========  ====== 

MPEG 1   X 

MPEG 2   X 

MPEG 2.5   X 

 

� File Tag - A file’s tag contains extra information about the file.  The tag typically contains the track 
name, artist, album, genre, year and comments. 

o ID3 v1 is the original tag type.  It is more common but it also is limited in the amount of 
information that it can display.  (Text fields are limited to 31 characters) 

o ID3 v2 is the latest tag type.  It can store more involved information, including videos, 
pictures and link information.  

o Mode (Channel Mode) - The channel mode determines if the resultant file will be mono or a 
stereo flavor. 

� Mono – One channel.   

� Joint Stereo – Toggles between stereo and mono depending on differences and 
similarities in the left and right channels. 

� Dual Stereo – 2 mono channels.  (Encoded independently.) 

� Stereo - Normal stereo ( 2 channels) 

o Constant Bit Rate - Choose this option if you want the resultant MP3 file to have a Constant 
Bit Rate (CBR).  The encoder will pad frames of the MP3 with filler data if necessary. 

o Variable Bit Rate - Variable Bit Rate (VBR) files will encode MP3 files that have a range of 
bit rates.  Why create more data is necessary?   The problem with VBR is that some players or 
MP3 devices may not play them back as well as Constant Bit Rate MP3 files. 

� Min Bit Rate – The minimum bit rate to use. 
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� Max Bit Rate – The maximum bit rate to use 

� Quality Level – Indicates how well the encoder analyzes the audio.  The more it 
analyzes the audio, the better chance it has of getting lower bit rate frames.  0 = 
highest quality and 9 = lowest quality.  

� Average Bit Rate - If set, the encoder will attempt to make the average bit rate equal 
to this value.  (It is assumed that it uses the highest quality level (0) in order to 
achieve the average bit rate.) 

o Extra Flags - Check these extra optional flags. 

o Private: This option  

o Original: Is this an original work ?   

o Copyright: Is this MP3 copyrighted?  

o Checksum: This option will add a checksum to the encoded file that will allow MP3 players to 
determine if the MP3 file has been corrupted or damaged.  The protected flag in the MP3 will 
be set. 

 

Mix Down to a WMA file 
WMA is a second-generation compressed audio format.  

 

From the "File" menu, select "Mix Down To" and then select "WMA File…" from the submenu.  Pick a 
name for your new WMA file. ( If you are going to be saving multiple WMA files for each CD Track 
Marker, this name will be the base name. ) 

 

After a name or base name is chosen, you need to set up extra parameters for the WMA file.   Once all the 
settings are made, click the Save button to render the session to a WMA file.  After it is finished, it will 
play the sound back via your default WMA player. 

 

o Destination File Size - This is a helpful indicator that estimates how big the destination file size is 
going to be.  

o Render All/Selection - The default is to render the entire session.  However, you can also render 
the current selection.  You might choose to render the selection if you want to hear how it sounds 
under a certain compression.  (You wouldn’t have to render the entire session which could take a 
while depending on the length of the session.) 

o Preset Quality - Adjust the slider and choose one of the presets to set the desired MP3 quality.   

The possible settings are: 

 

Preset Bit rate Mode  Frequency Response 

===== ====== =====  ================== 
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1  16 kbps Mono  8,000 Hz   

2  32 kbps Stereo  22,050 Hz 

3  48 kbps Mono  44,100 Hz 

4  64 kbps Stereo  44,100 Hz 

5  96 kbps Stereo  44,100 Hz 

6  128 kbps Stereo 44,100 Hz  (default) 

7  192 kbps Stereo 44,100 Hz 

 

o Entering File Information – Mixcraft adds authoring information to the WMA file.  You can fill in 
the Title, Author, Copyright, Genre, Year and Comment. 

o Create Separate WMA File For Each CD Marker? - This option will be enabled if you have more 
than 1 CD Track Marker.  If you select this option, Mixcraft will create a WMA file for each 
section of audio.  More on track markers 

 

Mix Down to a Realaudio file 
IMPORTANT: If you can not create Realaudio files, then you must download and install the optional 
Realaudio plugin from Acoustica @ http://www.acoustica.com/  

 

From the "File" menu, select "Mix Down To" and then select "RealAudio File…" from the submenu.  Pick 
a name for your new RealAudio file.  

 

What is RealAudio™ ? 

RealAudio is an audio format, which is highly compressed and small, allowing for real time streaming of 
audio over the Internet.  RealAudio is a proprietary technology owned by RealNetworks, Inc.  The latest 
version of RealAudio is called G2.  Its main feature is called SureStream, which allows for multi-rate 
RealAudio files. 

 

Exporting to RealAudio™. 

One of the convenient features of Mixcraft is the ability to instantly render the session into a RealAudio 
file. Simply select Save As.. from the File menu and change the file type to RealAudio™.   Select a 
filename and select the Save button.  This brings up the following dialog… There are several factors to 
consider. 

 

SureStream vs. Single Rate 

SureStream is RealNetwork’s multi-format file.  It’s the most important feature of G2.  You can create a 
SureStream file that will work with people connecting through a LAN, in addition to people with bit-
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pushin’ 28.8 modems!   The people with the higher speed connection will be served higher quality audio, 
while the people with the lower speed connection will be served the "less than perfect" audio.  You can 
have up to six target audiences. 

 

What’s the catch?  You need a RealServer G2 for playback!   (Your ISP may have a RealServerG2 already 
setup.) 

 

o Pressing ‘Preview’  will automatically render the first 5 seconds of the session with the selected codec . 

o Pressing ‘Fine Tune ’ will bring another dialog, which allows you to fine-tune the selected codec in 
case the preset codecs don’t sound good. 

o Selecting the "Create RealPlayer 5 Compatible Clip" will allow the older RealPlayer 5.0 players to 
play the clip.  It will make the clip slightly larger. 

o Single rate files can also be created.  These files can also be streamed via a traditional web server, just 
as if you were downloading a file.  

o Pressing ‘Preview’  will automatically render the first 5 seconds of the session of the current codec. 

o Pressing Fine Tune will bring another dialog, which allows you to fine-tune the current codec in case 
the preset codecs don’t sound good. 

 

Target Audience 

Who is the target audience?  Perhaps, you have a lot of corporate visitors with LANs, but you also have 
56K modem users.  You might select 2 target audiences (56K Modem and Corporate LAN).   

 

You can select up to 6 different target audiences if you are creating a SureStream.  If you are creating a 
single rate file, you can only select one target audience at a time. 

 

Content Type 

This one is pretty self-explanatory.  Is your masterpiece music or voice?  Or is it voice with background 
music?  If the stereo separation is an important part of the piece, you might select "Stereo Music".  The 
most important test is to simply listen to how it sounds in the various settings.  The preview feature makes 
it very easy to do this.  Take advantage of it. 

 

If you are going to eventually include this with a RealSlideshow™ or a RealVideo™, you should uncheck 
the "Audio Only?" checkbox which will adjust any selected codecs.  (It will lower the bit-rates to 
accommodate other data being downloaded.) 

 

Render All or Selection 
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One of the cool features of Mixcraft™  is that you can render selections anywhere in your session.  Select 
some sounds and press the RealAudio button.   Now you can press the "Render Selection" radio button, 
which will enable you to render the current selection!  This can be very handy if you are curious how a 
particular segment sounds, but you don’t want to render the entire one hour piece! 

 

Clip Information 

This is the information that is stored with the clip.  The name of the clip will default to the name of the 
main Sound Group.  The copyright and author information will default from the Miscellaneous information 
tab in the Preference dialog. 

 

RealAudio Fine Tune Dialog 

If you choose to fine-tune a codec, it will bring up this dialog (fig17b).  You may choose a different codec 
and preview it.  The bit-rate, frequency response, compatibility information and a detailed description are 
displayed as you switch between different codecs.  It will not allow you to exceed the maximum bit-rate for 
the target audience you are tuning. 

 

Note: It may take awhile for the RealAudio file to be completely rendered, depending on the power of your 
computer and the length of the session.  You may hit the cancel button to escape a lengthy encoding. 

 

Creating the RealAudio File (.ra) 

After you are happy with the settings, you should press the Save button on the main RealAudio dialog.  
Pick a filename and press "Save".  It may take awhile for the RealAudio file to be completely rendered, 
depending on the power of your computer and the length of the session.  You may hit the cancel button to 
escape a lengthy encoding.  By default, after it is finished encoding, it will play the newly rendered file. 

 

Optimizing your sound for RealAudio™ 

You may be wondering, "how can I improve the way that my RealAudio files sound?"  The rule of thumb 
is to not make your Sound Groups too quiet. If you feel they are too loud, simply turn your speakers 
down.  You will notice substantial improvements if the volume levels are kept as high as possible.  

 

If you have an external editor that can "compress" the sound, this may also help for RealAudio conversion.  
This is not the file type compression.  This is referring to dynamic amplitude compression.  Basically it 
takes the low parts of your sound and makes them louder, as well as taking the loud parts and making them 
quieter. 

 

Uploading it to the Internet. 

Mixcraft™ does not upload or publish the file to the Internet by itself.  You will find that most WEB page 
creation programs have this type of feature built in.  You may also choose to use a ftp program to upload 
the RealAudio file.   



 33 

 

Check the "Links" page on Acoustica for some links to sites that have useful information on uploading 
RealAudio files! 

 

 

 

MP3 Preset Quality 
The easiest way of choosing a level of compression for your MP3 files is to use the Preset Quality slider.   

 

The Preset Quality slider allows you to choose from several levels of quality and resultant file sizes.  As 
you choose higher quality, the file size goes up as well.  On the other hand, lower quality presets will be 
smaller and easier to send over the Internet. 

 

Preset  Bit rate  Channels     

=====  ======  =======    

Phone   16 kbps  Mono   

Shortwave 24 kbps  Mono  

AM Radio 32 kbps  Mono 

FM Radio* 96 kbps  Stereo 

Voice             64 kbps  Mono  

Radio  112 kbps Stereo 

Tape  128 kbps Stereo     

Hi-Fi  160 kbps Stereo  

CD  192 kbps Stereo   

Studio  256 kbps Stereo    

 

The default is CD quality (192 kbps, Stereo). 

 
* Note that the FM Radio bit rate is higher than the next preset quality, which is Voice.  Voice is @ 64 kbps and FM Radio is @ 96 
kbps.  The reason that there is a discrepancy is because Voice is mono and FM Radio is stereo.  If you were to divide the FM Radio 
bit rate in half, you would have 48 kbps per channel, which is lower than the Voice preset. 
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Keyboard Controls 
Keyboard shortcuts 

(<-  or ->  )    +/- quick move (depends on zoom level.) More..  

Ctrl + (<-  or ->  )   +/- 20 milliseconds. More.. 

Ctrl + Shift + (<-  or -> )  +/- 1 millisecond. More.. 

TAB     Select next sound.  More … 

Shift+TAB    Select previous sound. More … 

SPACE  bar    Start/stop playback. 

[Home]     Rewind playback indicator to 0. 

[End]     Fast forward playback indicator to end of Mix. 

[Delete]     Delete any selection of sound(s). 

+     Zoom in. 

-     Zoom out. 

Ctrl+Z     Undo. 

Ctrl+Y     Redo. 

Ctrl+X     Cut. 

Ctrl+C     Copy. 

Ctrl+V     Paste. 

Ctrl+A     Select All. 

Ctrl+N     New Mix. 

Ctrl+O     Open Mixcraft Project… 

Ctrl+S     Save. 

 
Nudging Sounds via the Keyboard 
You can move sounds via the keyboard. Use the arrow keys to move selected sounds! 

 

Moving horizontally along the timeline. 

Use the arrows to move the sound quickly.   

Hold down the Ctrl key and the sounds will move in increments of 20 milliseconds. Hold down the 
Ctrl+Shift key to move in increments of 1 millisecond. 

 

(<-  or ->  )    +/- quick move (depends on zoom level.) 

Ctrl + (<-  or ->  )   +/- 20 milliseconds 

Ctrl + Shift + (<-  or -> )  +/- 1 millisecond 

 

Moving sounds vertically 
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You can move the sound vertically as well.  You may do this if you are trying to move sound(s) to 
another track. 

 

Tabbing between Sounds via the Keyboard 
If you are interested in getting around quickly in the session and love the keyboard movement features, 
you will be happy to know that you can switch from sound to sound via the Tab key and Shift-Tab key 
combination.  

 

The Tab key will select the next sound on the current track or the first sound on the subsequent track.  (If 
you are at the end of the last track, it will go to the start of the first track.) 

 

Holding down Shift key and pressing the Tab key will do the opposite of Tab.  It will select the previous 
sound on the track.  If it is the first track, it will select the last sound on the previous track. 
 

 

Preferences 
Playback  

Recording  

Miscellaneous  

Information  

 

Playback Preferences 
If you have more than one soundcard, you can choose the soundcard you want for playback in the 
Playback device drop down at the top of window. 

 

If you select Use Best Quality, Mixcraft will always use the best sound format in the session as the default 
sound format.  Choosing this option will ensure that you don’t have any sound degradation.   

 

You may, instead, choose to use a specific format.  Wave formats have the following characteristics: 

 

• Sample Rate 

Sample rate simply means the number of times per second that the computer plays or records a 
snapshot of the sound.  Faster sample rates catch faster frequencies.  You may set the format to 
the following sample rates : 11,025 , 22,050, and 44,100, or you may type in a sample rate. 

• Bits Per Sample 

This determines the quality of each snapshot.  The more bits, the better.  You may set the format 
to either 8 or 16.  (8 has a tendency to sound fuzzy) 

• Number of channels 

Is it stereo or mono?  Setting the format to mono, will essentially disable panning. 
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The advanced section allows you to change the number of buffers and buffer size.  Without getting too 
complicated, you use these options to find a balance between audio discontinuity and playback latency. 

 

Latency is the amount of time it takes from the time you press the Play to the time you hear the sound.  If 
you feel the latency is to big, try reducing the number of buffers or the buffer size. 

 

Audio discontinuity is sometimes described as "popping" or "static".  The audio will drop in and out.  If 
you have audio discontinuity problems, try increasing the number of buffers and/or the buffer size. 

 

 

Recording Preferences 
Use the recording preferences to set the recording sample rate and other recording specific settings. 

 

� Full Duplex Test: Take this test to make sure that you can play and record sound at the same time. 

� Recording Settings 

o Sample rate: This is the number of times per second that an audio sample is recorded.  
CD quality is 44,100 samples per second. 

o Bit depth: 8 or 16 bits?  8 bit sound has a real high signal to noise ratio and sounds pretty 
noisy, especially for subtle and lower volume sounds.  If in doubt, choose 16 bits. 

o Channels: Stereo or mono?  If you are doing a lot of mono recordings and wish to cut 
down on hard drive space, choose mono.  Mono sounds are 2 times smaller than stereo 
sounds. 

o Overdub: If this is checked, Mixcraft will play sound while simultaneously recording. 

� Advanced Settings 

o Number of buffers: This is the number of buffers sent to the soundcard to be filled up 
with sound data.  Some soundcards, work better with more buffers. 

o Buffer size: This specifies the size of each buffer, in terms of kilobytes (KB).  Use larger 
buffers to reduce the change of losing parts of your recordings.  .  If you find that your 
recordings are missing sound or have static glitches, try increasing the number of buffers 
and/or the buffer size.    

� Temporary recording directory: This is where recordings will be created.  Make sure you have 
enough free space on the hard drive that your recording directory is on.  If you  want to record 
using your computer’s RAM, clear all characters from the edit box so that it is empty.  You should 
see "(RAM)" displayed above and then hit "OK". 

 

 

Miscellaneous Preferences 
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� Auto scroll during playback. - Normally, during playback if the indicator gets near the right end of 
the window, the view is scrolled over in time.  This option allows you to turn that off or back on. 

� Start playback at beginning when near end - Normally, if the session has played to the end, starting 
playback again will also cause the session to rewind to the beginning.  This option allows you to 
toggle the behavior. 

� Wave Display Resolution- Mixcraft can operate faster because it doesn’t load in a pixel for every 
sound sample.  It defaults to 1 milliseconds per pixel.  You can configure it to be anywhere from 1 
millisecond per pixel to 100 milliseconds per pixel. 

� Setting the playback indicator when clicking in the session window - If you click within the main 
window, this will cause the playback indicator to be set.  Normally, this only sets the caret (paste 
point).  If you are currently playing, it will restart playback from this position. 

� Play exported files after being created - After exporting a new file, this will automatically play back 
your freshly created sound.  Thus, you can preview it to make sure it sounds correct. 

� Editing sounds in an external editor. - If you want to edit sounds in an external editor, you need to 
select an external editor executable that MP3 Audio Mixer launches.  You can either type in the full 
path to the sound editor or press the Browse button to find it through Windows file system. 

� Temp directory – This is where all temporary cached peak (.IPK) and seek (.ISK) files are stored.  

 

 

Information Preferences 
The name, and copyright fields will automatically appear when rendering the session to a RealAudio™ 
MP3, WMA or Wave file.  This saves you the trouble of having to type it every time you want to export 
or render a file. 

 

� Author – Generally, this should be the organization or person who creates the audio mixes. 

� Copyright – This should be the copyright for the author or organization that does the creating. 

� Comments – These comments will be inserted into the comments section of your mixes. 

 

Menus 
File  

Edit  

Mix  

Sound  

Help  
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File Menu 

New Project 
This menu item clears the Mix.  If the current Mix has unsaved actions, Mixcraft will ask you if you’d 
like to save. 

 

Open Project… 
This menu item brings up a standard file dialog, which allows you to find a Mixcraft project file (.MXC) 
to load.  If the current Mix has unsaved actions, Mixcraft will first ask you if you’d like to save. 

 

Add Sound… 

This option allows you to add sound to the Mix. 

 

Import Playlist… 
This feature allows you to import play lists (.CBS, .M3U and .PLS).  Play lists are simply lists of sounds 
(MP3s, usually.)  Note that this will import Acoustica MP3 CD Burner play lists (.CBS). 

 

After selecting a play list to import, the Play List Wizard dialog will come up.  Choose which 
sounds/MP3s to import.  You can set how much overlap there is between the sounds.  Or you can set it up 
to have space between the sounds.  It can also create automatic CD Markers at the start of each new 
sound.  Click the "OK" button to import each sound and generate a mix.  This can be a very handy feature 
if you are a DJ and you have some existing play lists. 
 

Save Project 
This menu item saves the Mix as a Mixcraft Project file (.MXC ).  If the Mix has not been saved yet, it 
will bring up a standard file dialog allowing you to pick a filename and folder. 

 
Save Project As… 

This menu item allows the user to save the Mix with a different name.  You may elect to use this option if 
you are branching off in several possible sound designs and want to be able to compare them.  

  

Mix Down To… 
When you are ready to mix down your Mix, select one of the following formats from the sub-menu.  

 

Wave File  

MP3 File  

WMA File  

RealAudio™ File.  

 

Most Recent Files (8) 
Mixcraft displays the most recently used Mixcraft Project (.MXC) files here.  It will display the most 
recent 8 MXC files. 

 

Preferences… 
This brings up the Preference dialog.  
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Exit 
There’s always a time when you have to turn it off.  You can’t use Mixcraft all the time.  (We don’t mind 
that much, though. ;-) )   

 

This exits Mixcraft.  It will ask if you want to save, if the Mix needs to be saved. 

 

 

 

Edit Menu 
Undo 
Undo allows you to go back to previous states.  Undo is supported for the following actions. 

 

� Editing sounds & loops 

� Editing envelope points 

� Effect changes 

� Track adjustments 

 

Once you save, the Undo memory is cleared. (Thus, you cannot Undo after saving…) 

 

Redo 

Redo is the opposite or Undo.  For example, Sound Warrior adds an envelope point on his "angry-war-
cry.wav", then decides he doesn’t like it and does an Undo.  Suddenly, he thinks of the ancestors looking 
down upon him and decides to put it back by doing a Redo. � 

 

Copy 
Copy will take a snapshot of all currently selected sounds & associated envelopes.  Each successive Copy 
command clears the previous copied sounds.   Note that this will copy only the selected portions of the 
sound(s). 

 

Cut 
Cut will remove all currently selected portions of sounds and envelopes from the Mix.  It will also copy 
the selected portions of the sound(s) into the clipboard for pasting.  (Don’t worry, remember, you can 
Undo.) 

 

An alternative to Cut, is the ‘Delete’ key.  This will cut all the selected portions of sounds, but will not 
store them in the clipboard.  This is handy if you don’t want to overwrite the contents of the clipboard.  

 

Paste 

Paste will add all Copied sound(s) at the Caret position. 

 

Select All 
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All sounds will be selected. 

 

Zoom In 

Mixcraft allows you to zoom in up to a resolution of 1 pixel = 2 milliseconds. 

 

Zoom Out 
Mixcraft allows you to zoom out to a resolution of 1 pixel = 1 second. 

 

 

 

Mix Menu 
In addition to the menu bar, you can right click in the main session to get this menu. 

 

Add Sound… 

This option brings up a standard file dialog allowing you to select a new Wave file (.wav) to include in 
the current Sound Group.  It will appear at the current position of the Caret. 

 

Record Sound… 
This option brings up the recording dialog.  More on recording … 

 

Mix Info 

Mix Info is a dialog that allows you to change the name and associated comments.  It also displays the 
date it was created, its length in time, the number of sounds and a checkbox to display itself on start up. 

 

Play/Stop 

This option plays or stops the Main Sound Group. 

 

Rewind 

This causes playback to rewind to the beginning of the Main Sound Group.  This can happen during 
playback. 

 

Fast Forward 
This causes playback to fast forward to the end of the Main Sound Group.  You may use this option to get 
to the end of the Main Sound Group quickly. 

 

Waveform Display 
This brings up a window that shows a more detailed view of playback.  Note that clipping audio will be 
drawn in red. 
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Sound Menu 
You can also use the Sound menu by right clicking on a sound bar.  Make sure that the sound is selected 
first. 

 

Cut (on right click only) 

This will remove the sound from the Mix.  (You can always redo to get it back.) 

 

Copy (on right click only) 

This will copy the sound and it’s associated envelopes. 

 

Invert Envelope 

This is a helpful function, which changes each pivot point to an opposite or mirrored value.  (This can be 
undone, as well.) IE: For volume envelopes, volumes of 100% will go to 0%.  Volumes of 50% will stay 
the same.  Volumes at 33% will go to 66%, etc.  More on envelopes.  

 

Reset Envelope 

Have you added a billion pivot points to "godly.wav"?  Don’t want to undo everything else that you like, 
but you want to get this sound back to normal.  Simply select this Reset Envelope and it will be set back 
to the very original settings.  This works for each effect type separately, so you don’t have to cleanse the 
volume, if you’ve been mucking around with the Low Pass Cutoff.  More on envelopes. 

 

Edit Loop 
This launches the loop adjustment window, which allows you to define a looping area for a sound. 

 

Adjust Clip Playback Rate 
This allows you to choose a playback rate.  

 

Sound Info 

This brings up a dialog with information about the sound, including name, file path, format, length and 
size.  You can rename the sound if it appears to generic looking, ie: "untitled-wav-302123x12.wav" could 
be "john-tooted.wav".  Plus, it gives onlookers a brief laugh. 

 

Muted 

This either sets the sound to be muted or un-mutes the sound.  A check mark on the menu item indicates 
that it is muted. 

 

Locked 

This is a flag which tells you if the sound is locked in position.  If it has a check box next to it, it means 
that the sound bar is locked and cannot be moved.  To reposition a locked sound, un-toggle this option. 

 

Play/Stop 
This will play the sound if its not playing and stop it when it is.   
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Help Menu 
 

Help Contents 
This brings up this file.  (Of course, if you didn’t try that option, you may not ever see this. � ) 

 

Check For Update… 
This will communicate with the acoustica.com website to determine if a new version is available.  If so, 
you can click a link to take you the download page. 

 

Enter Registration Code 
This brings up a window, which allows you to enter your registration information to unlock the software 
into full functionality with no restrictions. 

 

Buy Now! 
This either launches a web browser or starts an integrated purchase system.  Once you’ve purchased the 
software, you will receive registration information. 

 

Acoustica Software Products 
This has a sub menu of other Acoustica software products.  All products have free trials.  Give them a try!  
If you like it, you can choose to buy it later! 

 

About Mixcraft… 
This brings up a dialog with some credits, copyright notices and cool artwork.  It also contains the built 
number, which may be important if you are seeking support. 

 

Toolbar 
The toolbar allows quick access to common functions. 

 

  Create a new Mixcraft project 

  Open/Load a Mixcraft project 

  Save 

  Add a sound (MP3, WAV or WMA) 

  Play/Stop 

  Rewind to the beginning 

  Fast Forward to the end 
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      Record 

  Select the active envelope (volume, pan, etc.) 

  Zoom In. 

  Zoom Out. 

  Preferences 

 Purchase the software.  (This goes away, if the software is already purchased.) 

 

 

Troubleshooting 
It’s Not Making Any Sound 

You’ve added sounds, but you can’t play anything...   There are a few things you can check here. 

 

1. Are the speakers on and plugged in?   (Sorry, management made us ask.) 

2. Can you play a Wave file through Windows sndrec32.exe or another sound application?    If you can't 
there may be a problem with your sound card's configuration or drivers.   Refer to your soundcard 
documentation to try to figure out what is wrong. 

3. Load the volume control that came with your soundcard and make sure that the Wave device is turned 
up. 

4. Another program may be using the Wave device.   Mixcraft will put up a dialog stating that another 
application has the Wave device in this case. 

 

Playback Is Stopping Too Soon! 

If you are trying to play sounds in Mixcraft and it seems to cut off too soon or it may have some 
other strange behavior, you should make sure that you have the latest drivers for your sound card.  
Download the latest drivers from your soundcard manufacturer’s website!  

Sound Is Breaking Up / Popping Or Clicking / Lagging 

When playing the session, it sounds like someone is starting and stopping the sound real quick, 
repeatedly. This could be because the computer has slowed down due to other programs running at 
the same time.  
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Mixcraft has to work harder as the layers of sound increase. Try increasing the buffer size or the 
number of buffers in the Advanced Section of the Preferences Playback tab. 

 

If you are doing a lot of recording and you find that the actual recordings are being broken up, you 
may change the Recording Settings on the Recording tab of the Preference Dialog. 

 

Additionally, you may choose to reduce the # of effects that you are using during recording.  Go 
ahead and mute the effects.  You can always turn them back on later.  (Effects use significant CPU 
power.) 

 

Another trick is to reduce the number of tracks.  Each track has its own separate mix down which 
costs in terms of your computer’s memory and CPU power.  If you don’t need sounds to be 
separate tracks, try and put them on as few tracks as possible.  

 

How Do I Cut And Paste Portions Of Sounds? 

You know how to copy a whole sound, but how do you copy part of a sound?  Left click on the 
bottom selection area of the sound .  Keep the left mouse button down and then move the mouse 
over the area you want to copy or cut.  A selection rectangle will highlight over the area of the 
sound.  Then let the mouse button up and select "Cut" or "Copy" from the "Edit" menu.  If you are 
"copying", you can then select "Paste" from the "Edit" menu to paste at the caret point. 

 

I Can’t Load Or Save WMA Files! 

In order to load and save to WMA files, you must have support for Microsoft Windows Media 
Format 7.1.  If you are trying to load a WMA file or export to WMA file and the option is grayed 
out, you probably do not have this installed.  To download and install it, please visit 
http://www.acoustica.com/plugins/index.htm .  (You do not need to restart your computer!) 

 

If you’ve already installed WMA support, you may be trying to open a WMA with Digital Rights 
Management (DRM).  If you created this WMA file with Windows Media Player, you could 
recreate it with DRM turned off.  To turn off DRM, run Windows Media Player, choose Options 
from the Tool menu, click on "Copy Music" and make sure that "Copy Protect Music" is 
unchecked.  You’ll have to recreate the WMA.  (The old one with DRM will not work.) 

I Can’t Preview Or Play Realaudio™ Files 

In order to hear RealAudio files, you must have the RealAudio player.  Download the latest player 
from http://www.real.com  

 

Mixcraft Won’t Load The Sound. It Says That The Format Is Unsupported 

There are many different types of sound file formats.  Mixcraft currently supports the Wave 
(.wav), MP3, and WMA formats.  Trying to load a .aif or .au will not work.   
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In addition, Mixcraft will work with Windows Audio Compression Manager (ACM) to load 
compressed wave files.   If it is a WMA file, make sure that WMA format support is installed. and 
that they file does not have Digital Rights Management (DRM) on it. 

 

I Edited A Sound In An Editor And It Messed Up Other Sounds! 

If you had copied a sound and then edited it in an external editor in the "Edit Original" mode, it 
would have made the copies reference the same sound file.  If the length was changed or if the 
sound were altered in a time specific way, Mixcraft would not have been able to load it back in the 
correct way.  Next time consider selecting the "Edit A Copy" option. 

 

How Do I Record From The CD? 

Mixcraft supports the recording of whatever sound that it is possible to record via your soundcard.   
Here are the steps to record your CD. 

Recording from the CD is simple as long as your soundcard is connected to your CD.  

1) Click on the speaker icon on the lower right hand corner of the window's desktop. If you do not 
have this, then you may need to add/remove programs and make sure you select all "multimedia" 
components. 

                 This should have brought up a window that is titled "Volume Control". 

2) Select "Properties" from the "Option" menu. 

                 This brings up another window 

3) Select the "Recording" option from the "Adjust Volume For" grouping. 

                 Look at the list box called "Show the volume controls." 

4) Make sure that the "CD Audio" option is selected. 

5) Hit OK 

                   Brings up the "Recording Control" window. 

6) Make sure that "CD Audio" option is selected and at a decent level.  

7) Put in an audio CD and start it playing. 

8) Launch Mixcraft 

9) Select the Record option and make sure the "Show Recording Level" is selected. 

                   You should see the level indicator moving in Mixcraft's recording level. 

                   Go back to the Recording Control window if it’s distorting. 

10) Hit the record button in the Mixcraft Record window and you are done. 
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 How Do I Set Mixcraft Up To Record From Memory (RAM)? 
Go to the preference dialog and remove all text in the edit box labeled "Temporary Recording 
Directory".  You should see the words "(RAM)" appear.  Then click "OK" and record to your 
heart’s content.   

 

I’m Not Hearing Real-Time Changes Of Effects During Playback! 

If you have some sounds selected, you will not hear your volume, pan, or clipboard changes 
during playback.   Once you restart playback after making a change, you will hear the changes.   

 

How Do I Overdub Or Record While Listening To My Other Tracks? 

You need to make sure that you have done the full duplex test and have the "Overdub" checkbox 
checked in the Recording Preferences.  Depending on your soundcard’s level of full-duplex 
support, you may need to set the recording sampling rate to be the same as the playback sampling 
rate. 
 

I Can’t Render To Realaudio.  It Says I Need To Download More Files! 

Not everyone uses Mixcraft to create RealAudio files.  We chose to leave out the RealAudio files 
and make it an optional download.  This makes the download much smaller.  Look for the 
RealAudio patch here.  

 

New Tracks Are Picking Up Sound From Old Tracks. 

Your new audio tracks are picking up remnants of other tracks.  Your microphone or input device 
is picking up the output from your speakers.  Try using headphones.  If that doesn’t work, your 
soundcard may have some touchy circuitry.  Go to your mixer's recording settings and make sure 
that only the devices you are interested in recording are set. 

 

 Recording Is Not Working! 

You’re mixing sounds great, but you can’t record anything!!!  There can be many reasons why this is not 
working.  Recording tips … 

 

1. Your microphone is not plugged in to the right hole in the back of your soundcard.  Sometimes it 
happens. �   

2. You’re trying to record on your CD but nothing is happening.  Make sure that your soundcard has 
a connection to your CD player.  This is usually an internal cable. 

3. Another problem for not recording is related to the Win95/98/NT audio mixer. 

� Double click the speaker icon on the lower right of your Window’s taskbar. 

� Select "Properties" from the Options menu. 
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� Select "Adjust volume for recording" radio button. 

� Make sure all the checkboxes are checked in the window entitled "Show the following 
volume controls" and press the "OK" button. 

� Make sure that the device you are trying to record is selected and the slider is up. 

� For example, if you are trying to record the CD,  make sure the checkbox enabled 
"Select" in the "CD Audio" panel is checked, then adjust the slider to about 75%. 

� Make sure that the overall "Recording" balance on the very left is also set at 50%. (On 
many systems, you cannot adjust this anyhow.) 

� Go back to Mixcraft and start recording! 

 

What Are These CD Track Marker Things? 

Track markers can be used to help organize your session.  But they can also be used in conjunction with a 
multi-WAV, MP3 or WMA mix down.  What’s that you say?  Lets say you created this 60 minute CD 
audio masterpiece that has 10 sections.  You invite your friend over and tell him to "listen to this one part."  
You spend 15 minutes trying to fast forward to the right spot and your friend loses interest!  Wouldn’t it 
have been better to just seek to track #8 ,for example?  Thus, you can place a marker at the exact spot and 
select the "CD Track" checkbox.  When you do a multi-WAV save, it will create multiple WAV files based 
on these "CD Track" markers.  Then, use your cd burning software and drag in the new files! 

 

I Can’t Render To Realaudio™ Files!  It’s Grayed Out! 

Realaudio is now a separate download in some cases.  You can download the Realaudio plugin for Mixcraft 
at http://www.acoustica.com/plugins/index.htm  

 

Hey, I Can’t Even Find My Problem In This Section! 

Start your Internet browser and go to http://www.acoustica.com/support.htm for the latest help.  You will 
even find some animated tutorials on the most common problems!  If it’s not on the website, you can 
request a support request from our online help form at to http://www.acoustica.com/support.htm !   

 

 

 

Version History 
To check for a new version, select "Check For Update" from the "Help" menu or you can visit the website 
at www.acoustica.com  

 

Version 1.0  - April 2004 

� Initial Release! 
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Acoustica was founded in 1998 and is located in the foothills of the Yosemite Valley.   Acoustica's 
mission is to create high quality, intuitive and powerful software.   We value diligence, creativity and 
innovation.   We are embracing Internet technology and the new world that it is creating.   We also have 
this curious idea that SOFTWARE SHOULD BE EASY TO USE! � 

 

Mixcraft is the latest in a series of highly innovational and user-friendly software we are making.  Our other 
products include MP3 To Wave Converter PLUS, MP3 Audio Mixer, MP3 CD Burner and CD/DVD Label 
Maker. 

 

Acoustica 
P.O. Box 728 

Oakhurst, CA 93644 

U.S.A. 

www.acoustica.com  

 

Copyright © 1998-2004 Acoustica.  All rights reserved.  No part of this manual may be copied, 
reproduced, translated or transmitted in any form by any means for any purpose without the express 
written permission of Acoustica. 

 

 

 

 

Decibel  (dB) 
The decibel (dB) is a logarithmic unit of relative measurement used to compare the ratio of 
the intensities of two signals.  When an amplitude doubles, the increase corresponds to 6 dB. 

 

 

WMA Files 
WMA stands for Windows Media Audio.  WMA files contain perceptually encoded sound 
data.   
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The frequencies that humans cannot perceive are removed, although some audio purists say 
they can tell the difference between a high bit-rate WMA and a Wave file.   

 

A WMA file can be as much as 20 times smaller than an equivalent WAV file.  

 

.WMA 

 

 

Sound Group File 
The project file for MP3 Audio Mixer. (.SGP) 

 

Codec 
Codec stands for coder – decoder.  In our case, codecs refer to small audio program-ettes, 
which convert compressed audio to uncompressed audio and vice versa. 

 

Mixcraft Project File 
The project file for Mixcraft™ (.MXC) 

 

Hertz (HZ) 
Hz is the rate at which the cycles of a periodic waveform repeat or cycles per second.  Humans can 
hear frequencies or Hz from 20 Hz to 20,000 Hz.  In reality, most humans can’t hear above 14,000 
Hz.  A low Hz or frequency will sound deeper and a high Hz or frequency will sound higher. 

 

Frequency Band 
A frequency band is range of frequencies, such as 6,000 Hz to 8,000 Hz. 

 

 

Gain 
Gain is a fancy word for amplification or volume adjustment.  Use it to impress your friends. 
�  By the way, thanks for looking this up.   
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Millisecond (MS) 
A millisecond (ms) is 1/1000th of a second.  Humans can’t hear changes that are less than 20 
milliseconds.  Rabbits can’t either, for that matter. ;-)  

 

 

 

 

Whooshes 
A very serious technical term that describes sound.  10 Whooshes = 1 Wahwah, for the quiz. 
�  (For those that don’t have a grin on their face, yet, this is a joke.) 

 

 

 

Clip 
A clip is a sound. 

 

 

Clipping 
Clipping is when the audio signal is too strong and surpasses the capacity to represent it.  It 
usually results in distortion, which sounds like bursts of noise.  Generally, you should avoid 
clipping! 

 

 

Peak 
A peak is the top of a wave form.  A Wave form represents the oscillations of a sound signal.  

 

 

Wave form 
A Wave form is a graphical representation of the oscillations and gyrations of a sound signal. 

 


